
 

Signal Processing Toolbox 
Release Notes

The “Signal Processing Toolbox 6.4 Release Notes” on page 1-1 describe 
the changes introduced in the latest version of the Signal Processing 
Toolbox. The following topics are discussed in these Release Notes:

• “New Features” on page 1-2

• “Major Bug Fixes” on page 1-3

• “Known Software and Documentation Problems” on page 1-4

• “Upgrading from an Earlier Release” on page 1-5

The Signal Processing Toolbox Release Notes also provide information 
about recent versions of the product, in case you are upgrading from a 
version that was released prior to Release 14SP2.

• “Signal Processing Toolbox 6.3 Release Notes” on page 2-1

• “Signal Processing Toolbox 6.2.1 Release Notes” on page 3-1 

• “Signal Processing Toolbox 6.2 Release Notes” on page 4-1

• “Signal Processing Toolbox 6.1 Release Notes” on page 5-1

Printing the Release Notes
If you would like to print the Release Notes, you can link to a PDF version.
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New Features
The following new features and enhancements have been added to the Signal 
Processing Toolbox Version 6.4.

Discrete-Time Filter Objects Delay Structure
A new delay structure (dfilt.delay) has been added to dfilt objects. This 
structure adds latency to any signal filtered with it.

WinTool/WVTool Normalize Magnitude
A Normalize magnitude option has been added to the Analysis Parameters of 
WinTool and WVTool magnitude plots.

FDATool Enhancement

Improved Plot Displays
The default plots for filter responses have been improved. The y-axis 
autoscaling includes buffer regions around the data and shows only the 
significant data. To see all of the data without any buffer regions, select Full 
view from the View menu.

FVTool Enhancements

Passband Zoom
If you have a filter in FVTool that was created in FDATool or from a Filter 
Design Toolbox fdesign object, you can use Passband on the View menu to 
zoom the passband region.

Improved Plot Displays
The default plots for filter responses have been improved. The y-axis 
autoscaling includes buffer regions around the data and shows only the 
significant data. To see all of the data without any buffer regions, select Full 
view from the View menu.
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Major Bug Fixes
To view major bug fixes made since R14SP2 for the Signal Processing Toolbox, 
use the Bug Reports interface on the MathWorks Web site.

Note  If you are not already logged in to Access Login, when you link to the 
Bug Reports interface (see below), you will be prompted to log in or create an 
Access Login account.

After you are logged in, use this Bug Fixes link. You will see the bug report for 
the Signal Proceesing Toolbox. The report is sorted with fixed bugs listed first, 
and then open bugs.

If you are viewing these release notes in PDF form on the MathWorks Web site, 
you can refer to the HTML form of the release notes on the MathWorks Web 
site and use the link provided. 
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Known Software and Documentation Problems
To view important open bugs in R14SP3 for the Signal Processing Toolbox, use 
the Bug Reports interface on the MathWorks Web site.

Note  If you are not already logged in to Access Login, when you link to the 
Bug Reports interface (see below), you will be prompted to log in or create an 
Access Login account.

After you are logged in, use this Open Bugs link. You will see the bug report for 
the Signal Processing Toolbox. The report is sorted with fixed bugs listed first, 
and then open bugs. You can select the Status column to list the open bugs first.

If you are viewing these release notes in PDF form on the MathWorks Web site, 
you can refer to the HTML form of the release notes on the MathWorks Web 
site and use the link provided. 
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Upgrading from an Earlier Release
There are no upgrade issues involved in moving from the Signal Processing 
Toolbox 6.3 to Version 6.4.

If you are upgrading from Version 6.2.1 or earlier, see “Upgrading from an 
Earlier Release” on page 2-4 in the Signal Processing Toolbox 6.3 Release 
Notes.
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New Features
The following new features and enhancements have been added to the Signal 
Processing Toolbox Version 6.3.

New spectrogram Function
This function replaces the grandfathered specgram function. It uses new 
default values and the order of the inputs has changed. If you use this function 
with no outputs, a surface plot is dispayed, instead of an image. See 
spectrogram for more information.

New gaussfir Function
This function replaces the grandfathered firgauss function. gaussfir uses 
parameters that are common to communications systems. See gaussfir for 
more information.

FDATool Enhancements

Tip of the Day
A new Tip of the Day dialog displays when you start FDATool. It contains tips 
and hints for using FDATool.

Spectral Rejection Masks
You can draw lines on your filter response in FDATool to indicate rejection 
areas.

Generated C Header File Complex Filter Support
FDATool now supports generating C header files for complex filters.

Analysis Parameters
Three new options have been added to the Analysis Parameters for magnitude 
response displays. These options are also available in FVTool.

• Normalize Magnitude to 1 (0 dB) — displays the magnitude so that the 
maximum magnitude value occurs at 0 dB

• Autoscale axes — automatically scales the response data y-axis
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• dB Display Range — If you are not using autoscale and the magnitude 
display is in dB, this allows you to specify the y-axis limits, .

FVTool Enhancements

SOS Filter Coefficients Display
The coefficient view in FVTool now displays each section of a second-order 
section filter as a separate filter with its own numerator, denominator, and 
gain.

New Demos
The Signal Processing Toolbox demos have been reorganized and a new demo 
on the analysis of a numerically controlled oscillator (NCO) has been added.
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Upgrading from an Earlier Release
This section describes the upgrade issues involved in moving from the Signal 
Processing Toolbox 6.2.1 to Version 6.3.

If you are upgrading from Version 6.2 or earlier, see “Upgrading from an 
Earlier Release” on page 4-8 in the Signal Processing Toolbox 6.2 Release 
Notes.

dfilt — Coefficients Method
The dfilt coefficients method has been changed to the coeffs method, which 
returns a structure. See the Methods section of dfilt for information.

dfilt — Passing Filter States
You cannot pass filter states (initial and final conditions) via the dfilt filter 
method. You must use the states property. See dfilt for more information.

FDATool — State Space Filters
FDATool no longer supports state space filters. If you load a saved session that 
contains a state space filter, it is converted to a direct-form II transposed filter.

Filter Wizard Product Dependency
The Filter Wizard no longer requires the Signal Processing Blockset. You can 
use the Filter Wizard if you have the Signal Processing Toolbox and Simulink 
installed. If you have the Signal Processing Blockset installed, more options 
are available. See dspfwiz for more information.

firpm and cfirpm Inputs
The firpm and cfirpm functions now take function handles as inputs instead 
of strings. 

FVTool — Default Phase Units
The default units for the phase response in FVTool have been changed to 
radians. This is consistent with the phasez function.
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Plotting PSD Objects and Function Output
The following functions and methods now generate standard MATLAB plots, 
instead of launching an interactive plot: 

• dspdata plot method

• spectrum psd, pseudospectrum, and msspectrum methods
• pburg
• pcov
• periodogram
• pmcov
• pmtm
• pwelch
• pyulear

Refer to the MATLAB documentation for information on plots.

Spectral Analysis Functions Inputs
pwelch (and the other spectrum analysis functions) no longer accept 'half' or 
'whole'. You must use 'onesided' or 'twosided' to indicate the type of 
analysis you want.
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Obsolete Functions from Version 6.3

Obsolete Functions from Version 6.2

*tfestimate, cpsd, and mscohere have new default values and, in some cases, 
produce different results. Refer to their reference pages for more information.

Oboslete 
Function

Replacement 
Function

specgram spectrogram

firgauss gaussfir

Oboslete 
Function

Replacement Function

psd psd method on spectrum object or plot method on 
dspdata.psd object

psdplot psd method on spectrum object or plot method on 
dspdata.psd object

pmem spectrum.yulear

remez firpm

cremez cfirpm

remezord firpmord

tfe tfestimate*

csd cpsd*

cohere mscohere*
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Known Software and Documentation Problems
The MathWorks Web site includes a list of known software and documentation 
problems in Version 6.3.

If you are viewing these release notes in PDF form on the MathWorks Web site, 
please refer to the HTML form of the release notes on the MathWorks Web site 
and use the link provided. 
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Enhancements
The following enhancements have been added to the Signal Processing Toolbox 
Version 6.2.1.

FDATool Enhancements

Changing the Order of Filters in a Cascaded Filter
The FDATool Filter Manager now has Up and Down buttons that allow you to 
rearrange the order in which filters are cascaded.

Exporting Filter Coefficient Files
You can now export filter coefficient files in either decimal or hexadecimal 
format from FDATool.

Exporting Lattice ARMA filters to C Header Files
You can now export Lattice ARMA filters to C header files from FDATool.

Changed Code Generation Dialogs Buttons
The code generation dialogs in FDATool now include Generate and Close 
buttons, instead of OK, Cancel, and Apply buttons

FVTool Enhancement

Numeric Format Selection in Coefficient Viewer
You can now select decimal or hexadecimal numeric format in the FVTool 
Coefficient Viewer. 
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Major Bug Fixes
The Signal Processing Toolbox includes several bug fixes made since Version 
6.2.1. This section describes the particularly important Version 6.2.1 bug fixes.

If you are viewing these Release Notes in PDF form, please refer to the HTML 
form of the Release Notes, using either the Help browser or the MathWorks 
Web site and use the link provided.

If you are upgrading from a release earlier than Version 6.2, then you should 
also see the bug fixes summary in the Signal Processing Toolbox 6.2 Release 
Notes.
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Upgrading from an Earlier Release
This section describes the upgrade issues involved in moving from the Signal 
Processing Toolbox 6.2 to Version 6.2.1.

If you are upgrading from Version 6.2 or earlier, see “Upgrading from an 
Earlier Release” on page 4-8 in the Signal Processing Toolbox 6.2 Release 
Notes.

Changes to Discrete-time Filters (DFILTs)
The ResetBeforeFiltering property of the dfilt object has been renamed to 
PersistentMemory. Refer to the dfilt reference page for information.

The NumSamplesProcessed property no longer displays automatially for every 
dfilt. You can view this property with the following command, where Hd is a 
created dfilt:

get(Hd,'NumSamplesProcessed')

Undo/Redo Removed from FDATool
The Undo and Redo buttons have been removed from FDATool.
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New Features
This section summarizes the new features and enhancements introduced in the 
Signal Processing Toolbox 6.2.

This section is organized into the following subsections:

• “Spectrum Objects” on page 4-2

• “Dspdata Objects” on page 4-2

• “Options Objects” on page 4-3

• “Filter States Objects” on page 4-3

• “Enhancements to Discrete-time Filter Objects” on page 4-3

• “Enhancements to Window Objects” on page 4-4

• “Enhancement to Spectral Estimation Functions” on page 4-4

• “FDATool Enhancements” on page 4-4

• “FVTool Enhancement” on page 4-5

Spectrum Objects
The Signal Processing Toolbox 6.2 adds a new spectrum object. Spectrum 
objects contain parameter information for a particular spectral estimation 
method (e.g., spectrum.welch). This object provides an improved way to view 
and manipulate spectral estimation parameters. See the spectrum reference 
page and the associated estimation method reference pages for more 
information.

Dspdata Objects
A new data object dspdata has been added. These data objects contain 
parameter information for spectral data. Available types of data objects are 
dspdata.msspectrum, dspdata.psd, and dspdata.pseudospectrum. These 
objects contain the mean-square spectrum data, the power spectral density 
data, and the pseudospectrum data, respectively. With these objects, you can 
apply methods that calculate certain values or modify the data, such as 
computing the average power, centering the DC value, converting the spectrum 
between one-sided and two-sided, and normalizing the frequency. You can plot 
the data in a new Spectral Analysis plot. See dspdata for information.
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Options Objects
A new options object dspopts has been added. This object contains optional 
parameter information for spectrum objects. You create options objects via 
methods on other objects. See dspopts for information.

Filter States Objects
A new filter states object filtstates with two properties—Numerator and 
Denominator, that contain the filter states for an IIR Direct-form I filter, has 
been added. The states property of a dfilt.df1, dfilt.df1t, dfilt.df1sos, or 
dfilt.df1tsos filter now contains a filtstates.dfiir object, instead of a 
double vector. See filtstates for more information.

Note that you cannot change the values in the Numerator or Denominator 
using this syntax:

Hd.states.numerator = [<data>]

Note  The sign of the Denominator states for dfilt.df1t and dfilt.df1tsos 
is negated from what it was in previous versions. Refer to the structure 
diagrams shown on the reference pages.

If you use the double command on a filter states object to get a vector of 
double-precision values of the numerator and denominator, the numerator 
values are listed first, followed by the denominator values. In previous 
versions, the denominator values were listed first.

States saved for SOS objects in previous versions cannot be loaded into the 
current version.

Enhancements to Discrete-time Filter Objects
• The leading coefficient of the denominator (a0) can not be set to zero.

• New methods have been added to dfilt objects:

- fcfwrite—writes an ASCII filter coefficient file.

- info—displays filter structure, order, stability and linear phase 
information.
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• The terminology used for multistage and second-order sections (SOS) filters 
has been clarified and some dfilt method names have been changed. SOS 
filters have sections, where sections compose a single filter. Cascade and 
parallel filters have stages, where each stage is a separate filter. See the 
“Methods” section of the dfilt reference page for information on methods 
related to sections and stages. The new or renamed methods are

- addstage—adds a stage to a parallel or cascade filter object.

- nstages—returns the number of stages in the filter.

- removestage—removes a stage from a parallel or cascade filter object.

- setstage—overwrites a stage of a parallel or cascade filter object.

Enhancements to Window Objects
Two new methods have been added to sigwin objects:

• winwrite—writes an ASCII file containing window weights

• info—displays information about the window object

Note  To obtain command line help for Signal Toolbox objects, type help 
objectname or help objectname/classname or help objectname/
methodname. For example, to display help on the psd class of dspdata, type 
help dspdata/psd and for help on the average power method, type help 
dspdata/avgpower.

Enhancement to Spectral Estimation Functions
All of the spectral estimation functions (pburg, pcov, peig, periodogram, 
pmcov, pmtm, pmusic, pwelch, and pyulear) now use the new Spectral Analysis 
plot when no output arguments are specified. For an example of this plot, see 
the spectrum reference page.

FDATool Enhancements
• A new graphical Pole/Zero Editor panel has been added. You can 

graphically edit the filter (move, add, and delete poles/zeros) and see the 
resulting effect on your filter design.
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• File->Export changes include adding the ability to export the filter directly 
to SPTool, exporting an ASCII coefficient file instead of a text file, exporting 
cascades and parallel structures, and general improvements to the dialog 
box. 

• FIR Constrained Least Squares (fircls) and complex and nonlinear-phase 
equiripple FIR (cfirpm) filters have been added as design methods.

• A Filter Manager has been added. You can use the Filter Manager to store 
and recall multiple filters in a single FDATool session. You can also use it to 
cascade filters easily.

• The Analysis Parameters dialog box has been reorganized and simplified. 
The Frequency Units field has been removed and a Normalized Frequency 
checkbox has been added. (This also applies to FVTool.)

FVTool Enhancement
From the command line, you can change the sampling frequency (Fs) for the 
filter(s) in FVTool. See the Controlling FVTool from the MATLAB Command 
Line section of fvtool for more information.

New Demos
Two new demos have been added:

• Waveform Generation — generates common waveforms, such as pulse 
trains.

• DTMF — generates telephone pad tones.
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Major Bug Fixes
The Signal Processing Toolbox includes several bug fixes made since Version 
6.1. This section describes the particularly important Version 6.2 bug fixes.

If you are viewing these Release Notes in PDF form, please refer to the HTML 
form of the Release Notes, using either the Help browser or the MathWorks 
Web site and use the link provided.

If you are upgrading from a release earlier than Release 13 with Service Pack 
1, then you should see the bug fixes summary in the Signal Processing Toolbox 
6.1 Release Notes.
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Platform Limitations

FDATool — 800 x 600 Resolution
On all platforms, FDATool requires a screen resolution of at least 800 x 600.
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Upgrading from an Earlier Release
This section describes the upgrade issues involved in moving from the Signal 
Processing Toolbox 6.1 to Version 6.2.

If you are upgrading from Version 6.0 or earlier, see “Upgrading from an 
Earlier Release” on page 5-5 in the Signal Processing Toolbox 6.1 Release 
Notes.

Discrete-Time Filter States Property
In previous version of the Signal Processing Toolbox, the output of the states 
property of a dfilt.df1, dfilt.df1t, dfilt.df1sos or dfilt.df1tsos object 
was a vector of doubles. In the current version, the output is a filtstates 
object, Hs. To obtain a vector of doubles from the Hs object, use

double(Hs)

You cannot load the states of an SOS object saved in a previous versions into 
the current version.

Note that the order of the double-precision numerator and denominator values 
differs from the order in previous versions. In the current version, numerator 
values are listed first, followed by denominator values.

Note also that the sign of the Denominator states for dfilt.df1t and 
dfilt.df1tsos is negated from what it was in previous versions. Refer to the 
structure diagrams shown on the reference pages.
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New Features
This section summarizes the new features and enhancements introduced in the 
Signal Processing Toolbox.

If you are upgrading from a release earlier than Release 13, then you should 
see “Upgrading from an Earlier Release” on page 5-5.

This section is organized into the following subsections:

• “Discrete-Time Filter Objects” on page 5-2

• “FDATool Enhancements” on page 5-2

• “FVTool Enhancements” on page 5-3

• “SPTool Enhancement—Filter Viewer” on page 5-3

Discrete-Time Filter Objects
Several new features have been added to discrete-time filter objects. For more 
information, see the dfilt reference page.

• New properties—You can now include initial conditions in your dfilt objects 
with the States and ResetBeforeFiltering properties. 

• New structure—An overlap-add FFT FIR filter structure has been added. 
See dfilt.fftfir.

• New method—The block method creates a Simulink block of the dfilt 
object. This method is available only if the DSP Blockset is installed.

• Array handling—Some dfilt methods can now take an array of objects as 
input.

• freqz method—The S output has been removed from the dfilt freqz 
method.

FDATool Enhancements
• Creating M-code—You can now generate an M-file that includes code for the 

filter designed in FDATool. Use Generate M-file on the Targets menu. Note 
that this option is available only for designed filters and is disabled if you 
perform any other action on the filter.
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• Zooming—Zoom menu items have been moved from the Tools menu to the 
View menu. Zooming in the x- and y-directions has been added. (This change 
also applies to FVTool, WinTool, and WVTool.)

• Complex filters—You can load complex filters into FDATool and view their 
step and impulse responses. (This change also applies to FVTool.)

• Exporting filters as text files—Exported text files now include more 
information in the file header (toolbox version number and filter structure 
information). Only coefficients can be exported as text files.

FVTool Enhancements
• Command line access—You can now control FVTool from the command line 

in the same manner as you control other figures using gcf. For example, you 
can turn on and specify the legend strings from the command line. See the 
fvtool reference page for more information.

• Overlaying responses—You can add a second response to the analysis 
display.

• Phase Delay—The phase delay response has been added to the available 
filter analyses. 

• Filter Information—Detailed filter information has been added to the filter 
analyses.

• Boundary masks—You can turn on filter specification lines in the analysis 
display to view the ideal filter response based on your filter specifications. 
Note that these lines can be turned on only for displays showing the same 
units as the units in which the filter was designed (e.g., Magnitude(dB) for 
filters designed in dB, Magnitude and Zero-phase for filters designed in 
linear).

SPTool Enhancement—Filter Viewer
Selecting the filter viewer in SPTool now starts FVTool.
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Major Bug Fixes
You can see a list of the particularly important Version 6.1 bug fixes. 

If you are viewing these Release Notes in PDF form, please refer to the HTML 
form of the Release Notes, using either the Help browser or the MathWorks 
Web site and use the link provided.
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Upgrading from an Earlier Release
This section describes the upgrade issues involved in moving from the Signal 
Processing Toolbox Version 6.0 to Version 6.1.

Uninstall Previous Versions Before Installing 
Version 6.1
Verson 6.1 of the toolbox relocates some files to improve performance, so you 
must completely uninstall all earlier version of the Signal Processing Toolbox 
before installing the R13+ version.

Caution  Uninstalling the toolbox deletes all files in the $MATLAB/toolbox 
signal directory. Backup any files you may need to another directory before 
performing the uninstall steps.

Close MATLAB before attempting to uninstall the toolbox.

On Windows systems, use the MATLAB Uninstaller which you can access 
from Start->Programs-> MATLAB 6.5-> Uninstall MATLAB 6.5. Select the 
Signal Processing Toolbox from the Uninstall Product List.

On Unix systems, use:

rm -rf $MATLAB/toolbox/signal

where $MATLAB represents the name of your top-level MATLAB installation 
directory. 

Filter Structure Name Changes
The following changes have been made to the names of some filter structures.

Old Name New Name

direct form direct-form
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New Warning Message for DFILT Filter method
If you pass initial condtions using the dfilt filter method, a warning 
message is displayed. The preferred way to pass initial conditions to a dfilt is 
with the new States method.

auto-regressive autoregressive

moving average moving-average

Old Name New Name
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